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PREFACE

Thank you for purchasing the Garmin®
StreetPilot® ¢550™,

Manual Conventions

When you are instructed to “touch”
something, use your finger to touch an
item on the screen.

You will see small arrows (>) used in the
text. They indicate that you should touch
a series of items. For example, if you
see “touch Where to? > Favorites” you
should touch the Where to? button, and
then touch Favorites.

¢550 Tips and Shortcuts
* To quickly return to the Menu page,
touch and hold Back.

* Touch ll and ll to see more

choices.
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PREFACE

Tell us how you like this manual!
Fill out the Product Documentation
Survey. Go to www.garmin.com/
contactUs/, and click Product
Documentation Survey.

Quick Links
+ Finding an address: page 7

*  Viewing the Map page: page 12
+ Using hands-free cellular phone
features: page 14

¢ Using the Garmin Lock™ anti-
theft feature: page 6

* Listening to MP3 files: page 24

¢ Transferring files to your ¢550:
pages 22-23

* Adjusting the volume: page 6

¢ Adjusting the brightness: page 6

¢ Cleaning and storing your unit:
page 31


http://www.garmin.com/contactUs/
http://www.garmin.com/contactUs/
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PREFACE

@ Warning

Failure to avoid the following potentially
hazardous situations could result in an
accident or collision resulting in death or
serious injury.

When installing the unit in a vehicle, place the
unit securely so that it does not interfere with
vehicle operating controls or obstruct the driver’s
view of the road (see diagram).

Do not mount Do not place
.4 ; _\~unsecured on
>\ the vehicle
2] dash.

is blocked.

Do not mount in front of an
airbag field of deployment.

When navigating, carefully compare information
displayed on the unit to all available navigation
sources, including information from street signs,
visual sightings, and maps. For safety, always
resolve any discrepancies or questions before
continuing navigation.

Always operate the vehicle in a safe manner.
Do not become distracted by the unit while
driving, and always be fully aware of all driving
conditions. Minimize the amount of time spent
viewing the screen of the unit while driving and
use voice prompts when possible. Do not input
destinations, change settings, or access any
functions requiring prolonged use of the unit’s
controls while driving. Pull over in a safe and
legal manner before attempting such operations.

The unit contains a non-user-replaceable,
rechargeable lithium-ion battery. The battery
may present a risk of fire or chemical burn if
mistreated.

* Do not remove from the unit, heat unit above
140°F (60°C), or incinerate.

+  Dispose of unit properly. Contact your local
waste disposal department for information on
properly disposing of lithium-ion batteries.

WARNING: This product, its packaging, and its components contain chemicals known to the State
of California to cause cancer, birth defects, or reproductive harm. This Notice is being provided

in accordance with California’s Proposition 65. If you have any questions or would like additional
information, please refer to our Web site at http://www.garmin.com/prop65.
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Caution

Failure to avoid the following potentially
hazardous situations may result in injury or
property damage.

The unit is designed to provide you with route
suggestions. It does not reflect road closures
or road conditions, traffic congestion, weather

conditions, or other factors that may affect safety

or timing while driving.

Use the unit only as a navigational aid. Do not
attempt to use the unit for any purpose requiring
precise measurement of direction, distance,
location, or topography. This product should

Important Information

PREFACE

not be used to determine ground proximity for
aircraft navigation.

The Global Positioning System (GPS) is
operated by the United States government,
which is solely responsible for its accuracy

and maintenance. The government’s system

is subject to changes which could affect the
accuracy and performance of all GPS equipment,
including the unit. Although the unit is a
precision navigation device, any navigation
device can be misused or misinterpreted and,
therefore, become unsafe.

MAP DATA INFORMATION: One of the goals of Garmin is to provide customers with the most
complete and accurate cartography that is available to us at a reasonable cost. We use a combination of
governmental and private data sources, which we identify in product literature and copyright messages
displayed to the consumer. Virtually all data sources contain inaccurate or incomplete data to some
degree. This is particularly true outside the United States, where complete and accurate digital data is

either not available or prohibitively expensive.

NOTICE TO DRIVERS IN CALIFORNIA AND MINNESOTA: State law prohibits drivers in
California and Minnesota from using suction mounts on their windshields while operating motor
vehicles. Other Garmin dashboard or friction mounting options should be used. For available accessories,
refer to the Garmin Web site at www.garmin.com. Also, refer to the Owner’s Manual for instructions on
using the included mounting disk with the suction cup mount. Garmin does not take any responsibility
for any fines, penalties, or damages that may be incurred as a result of disregarding this notice. (See
California Vehicle Code Section 26708(a); Minnesota Statutes 2005, Section 169.71)

NOTICE: This Category Il radiocommunication device complies with Industry Canada Standard RSS-310.

¢550 Owner’s Manual
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Product Registration

Help us better support you by
completing our online registration today!
Connect to our Web site at www.garmin
.com/registration/.

Use this area to record the serial number
(8-digit number located on the back

of the ¢550) in case your c550 needs
service. Keep the original sales receipt,
or a photocopy, in a safe place.

Serial Number:

Contact Garmin

Contact Garmin if you have any
questions while using your ¢550. In
the U.S.A. contact Garmin Product
Support by phone: 913/397.8200 or
800/800.1020, Monday-Friday,

8 AM-5 PM Central Time; or go to
www.garmin.com/support/, and click
Product Support.

In Europe, contact Garmin (Europe) Ltd.
at 44/0870.8501241.

vi

Software License

Agreement

BY USING THE ¢550, YOU AGREE TO BE
BOUND BY THE TERMS AND CONDITIONS
OF THE FOLLOWING SOFTWARE LICENSE
AGREEMENT. PLEASE READ THIS
AGREEMENT CAREFULLY.

Garmin grants you a limited license to use

the software embedded in this device (the
“Software”) in binary executable form in the
normal operation of the product. Title, ownership
rights, and intellectual property rights in and to
the Software remain in Garmin.

You acknowledge that the Software is the
property of Garmin and is protected under the
United States of America copyright laws and
international copyright treaties. You further
acknowledge that the structure, organization, and
code of the Software are valuable trade secrets

of Garmin and that the Software in source code
form remains a valuable trade secret of Garmin.
You agree not to decompile, disassemble, modify,
reverse assemble, reverse engineer, or reduce to
human readable form the Software or any part
thereof or create any derivative works based on
the Software. You agree not to export or re-export
the Software to any country in violation of

the export control laws of the United States of
America.

¢550 Owner’s Manual
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GETTING STARTED

GETTING STARTED

What’s in the Box?

€550 unit and vehicle suction cup mount.

FM TMC traffic receiver/12-Volt adapter to provide external power and traffic
information.

USB cable to connect the ¢550 to your computer. Your ¢550 connects to your
computer as a Mass Storage Device (see page 22).

Dashboard Disk to mount the suction cup mount on your dashboard (see page 30).

Yellow Sheet that contains your unit’s serial number, registration number for
registering on Garmin’s Web site, and unlock code for future reference.

Volume knob
Speaker

Looking at Your c550

Ball socket (for attaching
the suction mount

Internal
SD card slot microphone Mini-USB Power
MCX connector Power Audio out connector button
under rubber cap connector  (for optional Mic in (for an
(for an optional headphones or line  optional external
external antenna) out to stereo input) microphone)

¢550 Owner’s Manual 1



GETTING STARTED

Step 1: Mounting the ¢550

Select a suitable location to mount the ¢550 on your windshield. Clean and dry the
selected area of your windshield.

(2]
(1] ﬂ-»
=i ER u

Windshield

1. Plug the power cable into the back of the ¢550.
2. Place the suction cup on the windshield. Flip the lever back, toward the windshield.

3. Snap the socket on the back of the ¢550 onto the ball on the end of the suction cup
mount.

4. Plug the power cable into a power receptacle in your vehicle. Your unit should turn
on automatically if it is plugged in and your vehicle is running.

3]

To remove the ¢550 from the mount, turn the ¢550 as far as you can to the right or left.
Apply pressure in that direction until the ¢550 snaps off the mount.

To remove the suction cup from the windshield, flip the lever toward you. Pull the tab
on the suction cup toward you.

2 ¢550 Owner’s Manual



Step 2: Configuring the ¢550

GETTING STARTED

To turn on your ¢550, press and hold the () Power button on the side of the unit.
Follow the on-screen instructions to configure your ¢550.

Step 3: Acquiring Satellites

Go outdoors to an open area, away from tall buildings and trees. Turn on the ¢550.
Acquiring satellite signals may take 30-60 seconds.

The bars in the upper-left corner indicate satellite strength. When the bars are
green, your ¢550 has acquired satellite signals; you can find your destination and go

to it.

Step 4: Using the ¢550
@ Touch to find a destination.
® Touch to view the map.

@® Touch to make a call (when connected
to a cellular phone with Bluetooth®
wireless technology).

@ Touch to view traffic incidents, when an
FM traffic receiver is connected.

 Touch to listen to MP3 files loaded on
the SD card or “Garmin” drive.

@ Touch to adjust the 550’ settings.

ol & 3:37:

\D\ A Where t07?

SRS,

© Touch to adjust the brightness of the screen.

¢550 Owner’s Manual



GETTING STARTED

Finding Your Destination

The Where to? menu provides several different categories for you to use when you
search for locations.

12} ©

Lq ‘ﬁ Spell Name
Address | Go Home Food
Fuel
@ . Bank/ATM
ngy Favorites (Codging

Touch Where to?. Select a category. Select a sub-category.

(4] (5]

Fai Kansas City 3.2: N Sheraton Suites-Country
White Haven Motor Lc  3.3: W Club Plaza

74th St to Ward Pky

T70 W 4T7th St
Kansas City, MO
64112 Gol

El se-931-2400

Select a destination. Touch Gol. Enjoy the route!
Touch the arrows to see
more places.

TIP: Touch [JEMl and EEM (0 sce more choices.

4 ¢550 Owner’s Manual



GETTING STARTED

Following Your Route

As you travel, your ¢550 guides you to your destination with voice prompts, arrows
on the map, and directions at the top of the Map page. If you depart from the original
route, your ¢550 recalculates the route and provides new directions.

I 74th St to Ward Pky | eft on Ward Pky |

Your route is marked witha  Follow the arrows as you A checkered flag marks your
magenta line. take turns. destination.

Adding a Stop to Your Route

You can add a stop to your route. The ¢550 gives you directions to the stop and then to

your final destination.

1. With a route active, touch Menu on the Map page,
and touch ® Where to?.

2. Search for the extra stop. Prodimitiidict

3. Touch Go!. [ e

of The Capital Grill?
4. Touch Yes to add this stop before your destination.
Or, touch No to make this your new final destination.

@ NOTE: You can add only one stop to your route.

¢550 Owner’s Manual 5



GETTING STARTED

Adding a Detour

If a road on your route is closed, you can
take a detour.

1. With a route active, touch Menu.

2. Touch Detour.

Stopping the Route

1. With a route active, touch Menu.
2. Touch Stop.

Taking a Better Route

As you approach your destination, the
¢550 evaluates road options, which
may result in a better route. When the
¢550 finds a better route, ® or A\ is
displayed in the right corner of the map.
Touch @ or A\ to take the better route.

Adjusting the Volume

Turn the volume knob on the right side
of the unit to adjust the volume.

Adjusting the Brightness

On the Menu page, touch [ Touch

= to lower the brightness and # to raise
6

it. Touch OK when you are done.

Locking Your ¢550

1. On the Menu page, touch gl >
@, System.

2. Touch the button next to Garmin
Lock. Touch OK.

3. Enter a 4-digit PIN. Touch Yes to
accept the PIN.

4. Touch OK. Drive to a security
location, and touch Set.

Each time you turn on the ¢550, enter
the 4-digit PIN or drive to the security
location.

What is a Security Location?
You can select any location, such as
your home or office, for your security
location. If you are at your security
location, you do not need to enter a PIN.
If you forget your PIN, drive to your
security location to unlock the ¢550.

NOTE: To unlock your ¢550 at your
security location, the ¢550 must have

acquired satellite signals.

¢550 Owner’s Manual



@ WHEeRe To?

The Where to? menu provides several
different categories you can use to search
for locations. To learn how to perform a
simple search, see page 4.

Finding an Address
1. From the Menu page, touch
@ Where to? > (@ Address.

2. Select a state and city, if necessary.

3. Type the address number. Touch
Done.

4. Type the street name until a list of
streets appears, or touch Done.

5. Select the street.

6. Select a city, if necessary.

7. Select the address, if necessary. The
Go! page opens.

8. Touch Gol! to create a route to this
address.

TIP: You can search for a postal
code. Enter the postal code instead
of the city name. (Not all map data
provides postal code searching.)

¢550 Owner’s Manual

WHeRE To?

TIP: Finding an intersection is very
similar to finding an address. Touch
g;a Intersection, and enter the two
street names.

Go! Page Options
Touch an item in the search results list to
view the Go! page.

Sheraton Suites-Country
Club Plaza

770 W 47th St

Kansas City, MO
e4112

Bl s5-931-2400

Touch Go! to create a turn-by-turn route
to this location.

Touch Show Map to view this location
on the map. If the GPS is off, touch Set
Loc. to select this place as your current
location.

Touch Save to save this location as one
of your Favorites. See page 10.

If a cellular phone with Bluetooth
wireless technology is connected, touch
B (0 call this location.



WHERE To?

Go Home

You can set a home location for the place
you return to most often.

1. From the Menu page, touch
@ Where to? > 2% Go Home.

2. Select an option.

Going Home
After you set your home location, you
can route to it at any time by touching

@ Where to? > 4% Go Home.

Changing Your Home
Location

To change your home location, you must
first delete it from Favorites:

1. From the Menu page, touch

@ Where to? > @ Favorites.
2. Touch HOME > Edit > Delete > Yes.
After you delete your home location,
reset it by following the steps in the “Go
Home” section above.

Finding Points of Interest
1. From the Menu page, touch
% Where to? > @ Food, Hotels....
2. Select a category and a sub-category,
if necessary. (Touch the arrows to see
more categories.)

3. Select a destination.
4. Touch Go!.

Finding a Place by Spelling
the Name

If you know the name of the location you
are looking for, you can spell it using the
on-screen keyboard. You can also enter
letters contained in the name to narrow
the search.

1. From the Menu page, touch
% Where to? > @ Food, Hotels....

2. Touch Spell Name.

3. Using the on-screen keyboard, enter
letters in the name. Touch Done.

4. Touch the place you are looking for,
and touch Go!.

¢550 Owner’s Manual



Using the On-Screen
Keyboard

When an on-screen keyboard appears,
touch a number or letter to enter it. Use
the keyboard to spell words just like
computer keyboard.

Touch ﬂ to enter numbers.

Touch n to delete the last character
entered; touch and hold n to delete the
entire entry.

Touch to change the keyboard
mode to use diacritical characters or
special characters.

¢550 Owner’s Manual
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Finding Recently Found

Places

Your ¢550 stores the last 50 of your
recent finds in the Recently Found list.
The most recently viewed places appear
at the top of the list. From the Menu
page, touch % Where to? >

'@, Recently Found to view your
recently found items.

Deleting Recently Found
Places

To remove all places from the Recently
Found list, touch Clear. Then touch Yes.

NOTE: When you touch Clear, all
items from the list are removed. It
does not delete the actual place from
your unit.




WHERE To?

Favorites

You can save places in your Favorites,
so you can quickly find them and create
routes to them. Your home location is
also stored in Favorites.

Saving Places You Find

1. After you have found a place you
want to save, touch Save.

2. Touch OK. The place is saved in
@ Favorites.

Finding Saved Places
1. From the Menu page, touch
@ Where to?.

2. Touch @ Favorites. Your saved
locations are listed.

Saving Your Current Location
From the Map page, touch the /&)
vehicle icon. Touch Yes to save your
current location.

10

Editing Saved Places
1. From the Menu page, touch

@ Where to? > @ Favorites.

2. Touch the location you want to edit.
3. Touch Edit.

=]
Sheraton Suites-Country Cl

Change Fhone Number

4. Touch a button to edit the location:

Touch Change Name. Enter a new
name, and touch Done.

Touch Change Map Symbol. Touch
a new symbol.

Touch Change Phone Number.
Enter a phone number, and touch
Done.

Touch Delete to remove this item
from the Favorites list. Touch Yes.

¢550 Owner’s Manual



Finding a Place Using the
Map

Use the Browse Map page to view
different parts of the map. Touch

@ Where to? > Il >
@l Browse Map.

Tlps for Browsing the Map
Touch the map and drag to view
different parts of the map.

« Touch + and = to zoom in and out.

¢ Touch any object on the map. An
arrow appears pointing at the object
you selected.

¢ Touch Back to return to the previous
screen.

+ Touch Save to save this location to
your Favorites.

¢ Touch Go! to navigate to the selected
location.

o Ifthe GPS is off, touch Set Loc.
to set your location to the selected
location.

¢550 Owner’s Manual
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Expanding Your Search
1. From the Menu page, touch

% Where to? > Near....

2. Select an option:

Where | Am Now—searches for
places near your current location.

A Different City—searches for
places near the city you enter.

My Current Route—searches for
places along the route you are
currently navigating.

My Destination—searches for places
near your current route destination.

3. Touch OK.

NOTE: Your ¢550 automatically
searches for places near your current

location.

11



UsING THE MAIN PAGES

UsinG THE MAIN PAGES

Map Page _
On the Menu page, touch @ View map to open the Map page. The 8 vehicle icon
shows your current location.

To save your current location, touch Touch the text bar to open
the vehicle icon, and touch Yes. the Turn List page.

74th St to Ward Pky

Touch = to zoom out. Touch = to zoom in.

Touch Menu to return

to the Menu page. \

Touch Arrival or
Speedtoopenthe = T 34
Trip Information page.

Touch Turn In to open
the Next Turn page.

Map Page while Navigating a Route

% Keep left on Roancke

J-::‘E*.: 3.7 2.8, Pky Keep 1eft on
QECRTY # Roanoke
Musing Aug 500 Right on Ward Pky Pky

9.1z s
Total Tme | Moving Time | W Left on Jefferson St
03:3S 0(:(2 0223 | |-

Back Reset Trip | Reset Max
Trip Information Page Turn List Page Next Turn Page

ERH
0S:19
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Trip Information Page

The Trip Information page displays
your current speed and provides helpful
statistics about your trip. To view the
Trip Information page, touch Speed or
Arrival on the Map page.

Resetting Trip Information

If you want accurate trip information,
reset the trip information before
beginning a trip. If you make frequent
stops, leave the ¢550 turned on so it can
accurately measure elapsed time during
the trip.

Touch Reset Trip to reset the
information on the Trip Information
page. Touch Reset Max to reset the
maximum speed.

¢550 Owner’s Manual

UsING THE MAIN PAGES

Turn List Page

When you are navigating a route, the
Turn List page displays turn-by-turn
instructions for your entire route and the
distance between turns. Touch the green
text bar on the top of the Map page to
open the Turn List page. Touch a turn on
the list to view the Next Turn page for
that turn. Touch Show Map to view the
entire route on the Browse Map.

Next Turn Page

When you are navigating a route, the
Next Turn page shows the turn on the
map and the distance and time left before
you reach the turn. To view an upcoming
turn on the map, touch Turn In on the
Map page, or touch any turn from the
Turn List page.

Touch KM and I to view other
turns in the route. When you are finished
viewing the Next Turn page, touch Back.

13



UsING HANDS-FREE FEATURES

UsiINnG HANDS-FREE
FEATURES

Using Bluetooth® wireless technology,
your ¢550 can connect to your cellular
phone and become a hands-free device.
To see if your phone with Bluetooth

technology is compatible with the ¢550,

visit www.garmin.com/bluetooth/.

Understanding Bluetooth

Technology

Bluetooth® wireless technology
establishes a wireless link between two
devices, such as your phone and the

¢550. The first time you use two devices

together you must “pair” them by
establishing a relationship using a PIN/

passkey. After the initial pairing, the two

devices can connect automatically each
time you turn them on.

NOTE: You might have to set your

phone to connect automatically when

the ¢550 is turned on.

14

Pairing Your Phone

To pair and connect, your phone and the
¢550 must be turned on and be within 10
meters of each other.

Initiate pairing from your ¢550 or from
your phone. Refer to your phone’s
documentation.

To pair using the phone settings:

1. Enable the phone’s Bluetooth
component. This might be in a
menu called Settings, Bluetooth,
Connections, or Hands-free.

2. Initiate a search for Bluetooth
devices. This might be located in a
menu called Bluetooth, Connections,
or Hands-free.

3. Select the StreetPilot ¢550 from the
list of devices.

4. Enter the ¢550's Bluetooth PIN
(1234) into your phone.

5. On the ¢550, touch and hold Back to
return to the Menu page.

¢550 Owner’s Manual
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To pair using the c¢550 settings:
. On the ¢550’s Menu page, touch

B > Bluetooth.
2. Touch the Add button next to the
“Connections” heading.

3. Enable your phone’s Bluetooth
component and enable Find Me/
Discoverable/Visible mode. These
settings might be in a Bluetooth,
Connections, or Hands-free menu.

4. Touch OK on the ¢550.
5. Select your phone, and touch OK.

6. Enter the ¢550’s Bluetooth PIN
(1234) in your phone.

7. On the ¢550, touch and hold Back to
return to the Menu page.

When your phone is connected to your

¢550, you are ready to make phone calls.

Touch [JEg to access the Phone menu.

When you turn on the ¢550), it tries to
connect to the last phone with which it
was connected.
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Getting a Call

When you get a call, the Incoming Call
window opens.

Touch Answer to answer the call. Touch
Ignore to ignore the call and stop the
phone from ringing.

The internal microphone is in the front
of the ¢550; speak normally when on a
call. Adjust the volume using the volume
knob.
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UsING HANDS-FREE FEATURES

In a Call

After you have made or answered a call,
the [& In Call icon floats in the upper-
right corner of the screen. Touch [&J.

Touch Mute to mute the microphone.

To use automated systems, such as voice
mail, touch IEERM. Enter the required
information. Touch Back.

Touch End Call to hang up.
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Using Call Waiting

NOTE: If your phone does not
support call waiting through
Bluetooth, this feature will not work.

If you get a call waiting call, the 550
displays the Incoming Call window.
Touch Answer to answer the call. The
first call is placed on hold.

To switch between calls:
1. Touch [&] to open the In Call menu.

Call Time:
LIE-2-]

End Call

Switch To

2. Touch Switch To.

3. Touch End Call to hang up; this does
not disconnect the call on hold.
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Phone Menu

On the Menu page, touch g3l to open
the Phone menu. Press Status to view
the connected phone’s signal strength,
battery level, and name.

& &

mgn‘ &

Call Home| Vaice Dial

HE

ol

NOTE: Not all phones support all
features of the ¢550 Phone Menu.
For example, your phone might not
support voice dialing or phone book
transfer.
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Using Your Phone Book

NOTE: The Phone Book feature is
only available if your phone supports
phone book transfer.

Each time your cellular phone connects
with the ¢550, the phone book is
automatically loaded into the ¢550. It
may take a few minutes for the phone
book to be available.

1. On the Menu page, touch [Es3.
2. Touch |j¢] Phone Book.

Ann Smith 5551212
Home: 5553147
Larry

Mom 5550363 |
Sharon 5555514

3. Touch the phone book entry you want
to call.
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UsING HANDS-FREE FEATURES

Dialing a Point of Interest
1. On the Menu page, touch [Es3.

2. Touch G Food, Hotels....

3. Search for the point of interest you
want to call. Open the Go! page.

4. Touch Dial or @

Dialing a Number
1. On the Menu page, touch [Es3.

2. Touch £ Dial.

3. Enter the number, and touch Dial.
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Viewing Your Call History

NOTE: Call History is only
available if your phone supports call
history transfer.

Each time your phone connects to the
¢550, your call history is automatically
transferred to the ¢550. It may take a few
minutes to transfer this data to the ¢550.

1.
2.
3.

On the Menu page, touch B3l
Touch &) Call History.

Touch Missed, Dialed, or Received
to view those calls. The calls are
listed in chronological order; the most
recent calls are at the top of the list.

. Touch an entry to place a call to it.
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Calling Home
Enter a phone number for your home
location, so you can quickly call home.

Entering Your Home Location

and Phone Number

1. On the Menu page, touch [Es3l.

2. Touch &% Call Home.

3. If you have not set your home
location (page 8), follow the prompts
to set your home location. Touch
Save.

4. Touch Yes to enter a phone number.

5. Enter the phone number, and then

touch Done. The ¢550 dials your
home phone number.

Calling Your Home
1. On the Menu page, touch [Es3.

2. Touch &$§ Call Home.

3. The ¢550 dials your home phone
number.
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Placing Calls Using Voice Dial
@ NOTE: Voice Dial is only available

if your phone supports voice dialing.

You can place calls by speaking the
contact’s name.

1. On the Menu page, touch [Es3.

2. Touch & Voice Dial.

3. Speak the contact name.
NOTE: You may need to “train”
your cellular phone to recognize
your voice commands. Refer to your
phone’s documentation.
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UsiNGg FM TrAFFIC

Usine FM TrAFFIC

Use an FM TMC traffic receiver to
receive traffic information broadcast
over the FM Radio Data System. When
a traffic message is received, your ¢550
displays the incident on the map and can
change your route to avoid the traffic
incident. For coverage areas, refer to

the Garmin Web site at www.garmin
.com/fmtraffic.

NOTE: The FM traffic receiver and
¢550 must be in data range of an FM
station transmitting TMC (Traffic
Message Channel) data to receive
traffic information.

NOTE: Garmin is not responsible
for the accuracy of the traffic
information. The FM traffic receiver
simply receives signals from the

traffic service provider and shows
that information on your ¢550.

NOTE: You can only access the
traffic information if the ¢550 is

connected to an FM traffic receiver.
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Viewing Traffic Incidents

1. On the Menu page, touch [l to
display a list of traffic incidents.

2. Select an item to view details.
3. Select an option.

Traffic Symbols
Ar:::it:an Meaning International
@ Road Condition &
@ Road Construction A
@ Congestion &
@ Accident
<§> Incident A
0 Information
Severity Color Code

The bars to the left of the traffic symbols

indicate the traffic incident’s severity:

l Green = Low severity; traffic is flowing
normally.

Yellow = Medium severity; traffic is a

bit congested.

l Red = High severity; traffic is heavily

congested or stopped.
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Avoiding Traffic

The Map page displays O when there
is a traffic incident on your current
route or on the road on which you are
traveling,

[Exit 2224 right to 435 E/Us-1EaUs-5 |

1. From the Map page, touch ).
2. Select an item to view details.
3. Touch Avoid.

Purchasing an Additional
Traffic Subscription

If your subscription expires, you can
renew it at Garmin’s FM Traffic Web
site at www.garmin.com/fmtraffic. You
can purchase additional subscriptions at
www.garmin.com/fimtraffic.
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NOTE: You do not need to activate
the subscription included with your
FM traffic receiver (if it came with
one). The subscription activates
automatically after your c550
acquires satellite signals while
receiving traffic signals from the pay
service provider.

Adding a Subscription
1. On the Menu page, touch IS

2. Touch Il > @) Traffic.
3. Touch Add.
4

. Write down the FM traffic receiver’s
unit ID. Go to www.garmin.com/
fmtraffic to purchase a subscription
and get a code.

5. After you receive the 25-character
code, touch Next on the ¢550, and
enter the code.

6. Touch Done.

The traffic subscription code cannot be
reused. You must obtain a new code each
time you renew your service. If you own
multiple FM traffic receivers, you must
obtain a new code for each receiver.
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ManAGING FiLEs oN Your ¢550

MANAGING FILES ON YOUR
c550

You can store files, such as MP3s and
JPEG image files, in the ¢550’s internal
memory or on an optional SD card.

NOTE: The ¢550 is not compatible
with Windows® 95, Windows 98,

or Windows Me operating systems.
This is a common limitation of most
USB Mass Storage devices.

Supported File Types
MP3 music files (see page 24)

 JPEG and JPG image files for splash
screen (see page 27)

*  GPI custom POI files from Garmin’s
POI Loader (see page 35)

+  GPX waypoint files from MapSource
(see page 34)
* Maps from MapSource®

NOTE: The ¢550 does not support
M4A/MA4P files.
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Step 1: Insert an SD Card
(Optional)

To insert or remove the card, press it in
until it clicks.

Step 2: Connect the USB
Cable

1. Plug the small end of the USB cable
into the mini-USB connector.

2. Connect the larger end of the USB
cable to an available USB port on
your computer.
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Two additional drives appear in your
computer’s list of drives. “Garmin”

is the available storage in the ¢550’s
internal memory. The other removable
disk drive is the SD card.

NOTE: On some operating systems,
the ¢550 drives may not be named

automatically. See your operating
system’s Help file or page 39 to learn
how to rename the drives.

Step 3: Transfer Files to

Your ¢550

1. Connect the ¢550 to your computer.

2. Double-click &&] My Computer.

3. Browse your computer for the file you
want to copy.

4. Highlight the file, and select Edit >
Copy.

5. Open the “Garmin” drive or the SD
card drive.

6. Select Edit > Paste. The file appears
in the list of files on the ¢550 memory
or SD card.
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Step 4: Eject and Unplug
the USB Cable

When you are finished transferring files,
double-click the £ Unplug or Eject
icon in your Windows system tray.

Select USB Mass Storage Device, and
click Stop. Select the ¢550 drives, and
click OK. You can unplug the USB cable
from your ¢550 now.

Deleting Files from Your
c550

With the ¢550 connected to your
computer, open = My Computer.
Open the “Garmin” or SD card drive.
Highlight the file that you want to
delete, and press the Delete key on your
computer’s keyboard.

CAUTION: If you are not sure
about a file’s purpose, do NOT
delete it. Your c550 memory contains
important system files that should
NOT be deleted. Be especially
cautious of files located in folders
entitled “Garmin.”
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LisTeNING TO MP3 FiLes

LisTeNING To MP3 FILES

Load MP3 files to the internal memory
or SD card using USB Mass Storage.
See pages 22-23 for more information.

1. On the Menu page, touch .
2. Touch Browse.

3. Touch a category.

4

. To play the entire category from the
beginning of the list, touch Play All.
To play starting with a specific song,
touch the title.
5. Touch Back to exit the music page to
view other pages, such as the map.

B Lo B =
(Various) -
EXDTICA (Chill-Out Paradise Vol.) gy
Sleren = Track 2 =

D00 [ 003 =

11 ,_//
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Tap @ to go to the beginning of the
song; touch and hold to skip back.

Tap ® to skip to the next song; touch
and hold to skip ahead.

Touch @ to stop the song.
Touch @ to pause the song.

Touch to repeat. Touch to
shuffle.

Touch the album art to view details
about the MP3 file.

only; it does not support M4A/M4P
files.

@ NOTE: The ¢550 plays MP3 files
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CusTtomizING THE ¢550

1. From the Menu page, touch H
2. Touch the setting you want to change.

% @
Map System Locale
2 o
Display | Navigation| Bluetooth

3. Touch the button next to the setting
name to change it.

Changing the Map
Settings

From the Menu page, touch H >
Map.

o oo
o v
v
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Map Detail—adjust the amount of detail
shown on the map. Showing more detail
may cause the map to redraw slower.

Map View—change the perspective of
the map.

* Track Up—display the map in 2
dimensions (2D) with your direction
of travel at the top.

¢ North Up—display the map in 2D
with North at the top.

+ 3D—display the map in 3 dimensions
(3D) in Track Up.

Vehicle—touch Change to change the

icon used to display your position on

the map. Touch the icon you want to
use, and then touch OK. Download
additional vehicle icons at www.garmin

.com/vehicles.

Map Info—view the maps loaded on
your ¢550 and their version. Touch a
map to enable (check mark) or disable
(no check mark) that map.

Restore—restore the original map
settings.
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CusTomizING THE ¢550

Changing the System
Settings

From the Menu page, touch =l
@ System.

GPS Mode—enable and disable GPS
and WAAS/EGNOS. See www
.garmin.com/aboutGPS/waas.html for
information about WAAS/EGNOS.

Safe Mode—turn on or off Safe Mode.
When your vehicle is moving, Safe
Mode disables all functions that require
significant operator attention and could
become a distraction while driving.

Garmin Lock—turn on Garmin Lock™
to lock your ¢550. Enter a 4-digit PIN,
and set a security location. For more
information, see page 6.

Proximity Alarms—turn on or off the
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alerts when you approach Custom POls.
This option is only visible if you have
loaded Custom POIs. See page 35 for
more information about Custom POls.

About—display your c550’s software
version number, unit ID number, and
audio version number. You need this
information when you update the system
software (see page 33) or purchase
additional map data (see page 33).

Restore—restore the system settings.

Localizing Your ¢550

From the Menu page, touch [~ B
& Locale.

United States
A% English
<@ American English |

To change a setting, touch the button
next to the icon.
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To change all settings, touch Change
AlL In each screen, touch the button next
to the setting you want, and then touch
Next.

Locale—select your location.

(8% Text Language—change all
on-screen text to the selected language.
Changing the text language does not
change the language of user-entered data
or map data, such as street names.

& Voice Language—change the
language for voice prompts. Languages
noted with a person’s name are text-
to-speech (TTS) voices, which have an
extensive vocabulary and pronounce
the street names as you approach

turns. The pre-recorded voices (those
without a person’s name) have a limited
vocabulary and do not speak names of
locations or streets.

©) Time Format—choose a 12-hour,
24-hour, or UTC time format.
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Time Zone—select a time zone or
nearby city from the list.

Daylight Saving—set to On, Off , or
Auto, if it is available.

Units—change units of measure to
Kilometers or Miles.

Customizing the Display
From the Menu page, touch n >
& Display.

-
i
s s

Color Mode—select Daytime for a
light background, Nighttime for a dark
background, or Auto to automatically
switch between the two.

Splash Screen—select an image to be
shown when you turn on the ¢550. First,
load JPEG images. See pages 22-23.
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CusTomizING THE ¢550

Screen Shot—enable Screen Shot mode.
Touch the i camera icon to take a
picture of the screen. The picture bitmap
file is saved in the Garmin\scrn folder
on the “Garmin” drive.

Changing the Navigation
Settings

From the Menu page, touch =l
B Navigation.

Sp—
wcn
odmns
Attention Tone “

Route Preference—select a preference
for calculating your route. Select Faster
Time to calculate routes that are faster
to drive but can be longer in distance.
Select Shorter Distance to calculate
routes that are shorter in distance but can
take more time to drive.
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Vehicle Type—specify your vehicle type
to optimize routes.

Avoidances—select the road types you
want to avoid on your routes. The ¢550
uses these road types only if alternative
routes take you too far out of your way
or if no other roads are available. If you
have an FM traffic receiver, you can also
avoid traffic incidents.

Attention Tone—turn on or off the
attention tone.

Restore—restore the original navigation
settings.

Bluetooth Technology
Settings

From the Menu page, touch | = B
@ Bluetooth.

Connections—select a device to connect
to. Select Add Device to pair with

a cellular phone that has Bluetooth®
wireless technology. See pages 14-17.
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Touch Change if you want to connect to
a different phone in the list. Select your
phone, and touch OK.

NOTE: The ¢550’s PIN code (or
passkey) is 1234,

Drop—select the phone you want to
disconnect, and touch Yes.

Remove—select the phone you want
to delete from the ¢550’s memory,
and touch Yes.

Enabled

Bluetooth—enable and disable the
Bluetooth component. The & Bluetooth
icon appears on the Menu page if the
Bluetooth compnent is enabled. To
prevent a phone from automatically
connecting, select Disabled.
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Friendly Name—touch Edit to enter

a friendly name that identifies your
¢550 on cellular phones with Bluetooth
technology. Touch Done.

Restore—restore the original Bluetooth
settings. Restoring the Bluetooth settings
does not clear the pairing information.

Restoring All Settings
1. From the Menu page, touch 1.
2. Touch Restore.

Clearing User Data

CAUTION: This deletes all user-
entered information.

1. Hold your finger on the lower-right
corner of the ¢550’s screen while
turning on the ¢550.

2. Keep your finger pressed until the
pop-up window appears.

3. Touch Yes to clear all user data.

All original settings are restored. Any
items that you have saved are erased.
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APPENDIX

Mounting on Your Dashboard
Use the enclosed mounting disk to
mount your unit to the dashboard and to
comply with certain state regulations.

Important: The permanent mounting
adhesive is extremely difficult to remove
after it is installed.

To install the mounting disk:
1. Clean and dry the dashboard where
you are placing the disk.

2. Remove the backing from the
permanent mounting adhesive on the
bottom of the disk.

3. Place the disk on the dashboard.

4. Place the suction cup mount on top of
the disk. Flip the lever down (toward
the disk).

Suction
cup
mount
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Resetting Your ¢550

If your unit locks up (freezes up), press
and hold the () Power button to turn off
the unit. Then turn the unit back on. If
this does not help, reset your ¢550.

To reset the ¢550:
1. Place your thumb nail in the groove

located under the Garmin logo on the
Reset button

faceplate.

2. Gently pull off
the faceplate.

3. Press the
Reset button.

4. Connect the
c550to a Faceplate Power button
power source using the power cable.
The ¢550 should automatically turn
back on and operate normally.

NOTE: If you need to reset your unit
often, update the system software.

See page 33 for information about
updating the software.
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Caring for Your ¢550

Your ¢550 contains sensitive electronic
components that can be permanently
damaged if exposed to excessive shock
or vibration. To minimize the risk of
damage to your ¢550, avoid dropping
your unit and operating it in high-shock
and high-vibration environments.

Cleaning the Unit

The ¢550 is constructed of high-quality
materials and does not require user
maintenance other than cleaning. Clean
the unit’s outer casing (not the touch
screen) using a cloth dampened with

a mild detergent solution, and then
wipe dry. Avoid chemical cleaners

and solvents that can damage plastic
components.

Cleaning the Touch Screen

Clean the touch screen with a soft, clean,

lint-free cloth. Use water, isopropyl
alcohol, or eyeglass cleaner, if needed.
Apply the liquid to the cloth, and then
gently wipe the touch screen.
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Protectlng Your ¢550
* Carry and store your ¢550 in the
included carry case.

Do not store the ¢550 where
prolonged exposure to extreme
temperatures can occur (such as in
the trunk of a car), because it can
cause permanent damage.

Do not expose the ¢550 to water.
Contact with water can cause this unit
to malfunction.

+ Though a PDA stylus can also be
used to operate the touch screen,
never attempt this while operating
a vehicle. Never use a hard or sharp
object to operate the touch screen or
damage may result.
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Avo:dlng Theft
To avoid theft, remove the ¢550 and
mount from sight when not in use.
Remove the mark on the windshield
left by the suction cup.

* Do not keep your unit in the glove
compartment; thieves know where to
look.

* Register your product at www
.garmin.com/registration. This may
help if your unit is stolen.

™

» Use the Garmin Lock™ feature. See
page 6.

Changing the Fuse

An AGC/3AG 2-Amp, high-breaking
capacity, 1500 A-rated fuse is located
at the tip of the vehicle adapter.
Periodically, you may need to change
the fuse. Unscrew the black, round end
piece, and replace the fuse.

Unscrew
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Charging the ¢550

To charge the ¢550, connect the power
cable to the ¢550 and a power source.

Calibrating the Screen

If the touch screen is not responding
propetly, calibrate the touch screen.
Turn the unit off, Press and hold the (D
Power button for about one minute until
the Calibration screen appears. Follow
the on-screen instructions.

Using a Remote Antenna
You can use an optional external remote
antenna (Garmin GA 25MCX). To
purchase, go to the Garmin Web site at
www.garmin.com/products/sp550, and
click the Accessories link.

Remove the weather cap from the
antenna connector located on the
left side of the ¢550, and connect the
antenna.
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Updating the ¢550
Software

Use WebUpdater to update your ¢550
software. Go to www.garmin.com/
products/webupdater/ to download the
WebUpdater program.

After downloading WebUpdater to your
computer, connect your ¢550 to your
computer, run WebUpdater, and follow
the screen prompts. After confirming
that you want to perform an update,
WebUpdater automatically downloads
the update and installs it on your ¢550.

If you register your ¢550, you will
receive notification of software and map
updates. To register your c550, go to
WWWw.garmin.com/registration/.

You can also download software updates
from www.garmin.com/products/

sp550. Click Software Updates. Click
Download next to the unit software.
Read and agree to the terms. Click
Download. Select Run (or Open). Your
software is updated.
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Purchasing and Loading
Additional MapSource
Maps

To find out the version of the maps that
are loaded on your ¢550, open the Menu
page. Touch [[ERgl > [ Map > Map
Info. To enable additional maps, you
need your unit ID (see page 26) and
serial number (see page vi).

Check www.garmin.com/unlock/update.
jsp to see if an update for your map
software is available.

You can also purchase additional
MapSource map data from Garmin and
load the maps on your ¢550’s internal
memory or on an optional SD card.

To load maps to your ¢550 memory

or SD card, select the name for your
“Garmin” drive or SD card drive. Refer
to the MapSource Help file for more
information about using MapSource and
loading maps on your ¢550.
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APPENDIX

Loading MapSource
Waypoints on Your ¢550
Using MapSource, you can save
locations (also called waypoints) and
transfer them to your ¢550. For more
information about creating waypoints in
MapSource, see the Help file (press F1
to open the Help file).

After you have created the waypoints,
select File > Save. Select GPS
eXchange Format (*.gpx) for the Save
as Type. Click the Save button.

With your ¢550 connected to your
computer, copy the *.gpx file into the
Garmin\gpx folder in the “Garmin”
drive. The waypoints you created in
MapSource are now in ® Where to?
> @ Favorites.

Viewing Your Saved
Locations in MapSource

You can also view the locations you have
saved in your ¢550 using MapSource.
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In MapSource, select File > Open.
Select GPS eXchange Format (*.gpx)
for Files of Type. Browse to find the
Garmin\gpx folder on your “Garmin”
drive. Select Current.gpx, and click
Open.

Using the Garmin Travel

Guide™

Much like a paper travel guide, the
Garmin Travel Guide provides detailed
information about places, such as
restaurants and hotels. To purchase

the Travel Guide accessory, go to the
Garmin Web site at www.garmin.com/
extras. You can also contact your Garmin
dealer to purchase accessories.

To use the Travel Guide:
1. Insert the SD card into your ¢550.

Touch ® Where to? > @) Extras.
Touch the Travel Guide.

Touch a category. Touch a sub-
category, if necessary.

5. Touch a location in the list.

> LN
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6. Do one of the following:
Touch Go to go to the location.
Touch Map to display this item on a
map.
Touch Save to save this location in
your Favorites.

Touch More to view more information
about the location.

Custom POls (Points of
Interest)

Load custom points of interest (POls)
onto your ¢550. POI databases are
available from various companies on

the Internet. Some custom databases
contain alert information for points, such
as safety cameras and school zones.

You will receive a warning if you are

traveling too fast near these custom
POIs.

Use the Garmin POI Loader to load POIs
into your unit. Download the POI Loader
from www.garmin.com/extras.
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Using the POI Loader program, you
can store the Custom POIs on your
“Garmin” drive or your SD card. You
can also customize the proximity alert
settings for each POI using the POI
Loader. Refer to the POI Loader Help
file for more information; press F1 to
open the Help file.

To view your Custom POls, touch
% Where to? > @ Extras >
Custom POIs.

To delete the Custom POIs from

your ¢550, connect your ¢550 to your
computer. Open the Garmin\poi folder
in the “Garmin” drive or the SD card
drive. Delete the file entitled poi.gpi.

CAUTION: Garmin is not
responsible for the consequences

of using a custom POI database or
the accuracy of the safety camera or
other custom POI database.
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Battery Information

Your unit contains an internal (non-
removable) lithium-ion battery. The
battery should last up to 8 hours,
depending on usage.

The (888 battery icon in the corner of
the Menu page indicates the status of the
internal battery. If the icon is not present,
the ¢550 is connected to external power.

Contact your local waste disposal
department for information on properly
disposing of the unit.

Max:mlzmg the Battery Life
Turn off GPS (IESE > @ System
> GPS Mode > GPS Off) when you
do not need to receive GPS signals,
or use Normal mode when you do
not need to use WAAS or EGNOS.

¢ Turn the backlight brightness down
(on the Menu page, touch [IES).

Do not leave your ¢550 in direct
sunlight. Avoid prolonged exposure
to excessive heat.
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About Satellite Signals
Your ¢550 must acquire satellite signals
to operate. If you are indoors, near tall
buildings or trees, or in a parking garage,
the ¢550 cannot acquire satellites.

Go outside to an area free from tall
obstructions to use your ¢550.

When the ¢550 has acquired satellite
signals, the signal strength bars on the
Menu page are green ammlll. When it
loses satellite signals, the bars turn red or
disappear oo,

For more information about GPS, visit
www.garmin.com/aboutGPS.
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Technical Specifications

Physical size: 4.4” Wx 3.2”Hx 22" D
(11.2x 8.2x 5.6 cm)

Weight: 0.59 pounds (269 g)

Display: 2.8” Wx 2.1” H (7.2 x 5.4 cm);
320 x 240 pixels; bright, 16-bit LCD,
with white backlight and touch screen

Case: Not waterproof

Temperature range: 32°F to 140°F
(0°Cto 60°C)

Data storage: Internal memory and
optional removable SD card. Data stored
indefinitely.

Computer interface: USB mass storage,
plug-and-play

Charge time: Approximately 4 hours
Power input: 12/24 VDC
Usage: 15 W max. @ 13.8 VDC

Battery life: up to 8 hours depending on
usage

CAUTION: The ¢550 is not
waterproof.

¢550 Owner’s Manual
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GPS Performance
Specifications
Receiver: WAAS enabled
Acquisition times*:
Warm: <1 sec

Cold: <38 sec

Factory Reset: <45 sec

*On average for a stationary receiver
with a clear view of the sky

Update rate: 1/sec, continuous

GPS accuracy:
Position: <10 meters, typical
Velocity: 0.05 meter/sec RMS

GPS (WAAS) accuracy:
Position: <5 meters, typical
Velocity: 0.05 meter/sec RMS

For a complete list of specifications, see
www.garmin.com/products/sp550/spec
html.
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APPENDIX

Troubleshooting

Problem/Question

Solution/Answer

My ¢550 never gets
satellite signals.

Take your ¢550 outside, away from tall buildings and
trees.

My phone will not
connect to the ¢550.

Verify that the Bluetooth field is set to Enabled.

Make sure your phone is turned on and is less than 10
meters (about 33 feet) away from your ¢550.

See www.garmin.com/bluetooth for more help.

How do | know my
€550 is in USB Mass
Storage Mode?

When your ¢550 is in USB Mass Storage Mode, a picture
of a ¢550 connected to a computer is shown. Also, you
should see two new removable disk drives listed in My
Computer.

My computer never
senses that the ¢550
is connected.

1. Unplug the USB cable from your computer.
2. Turn the ¢550 off.
3. Plug the USB cable into your computer and your

¢550. The ¢550 automatically turns on and goes into
USB Mass Storage Mode.

| cannot find any
drives named
“Garmin” in my list of
drives.

If you have several network drives mapped on your
computer, Windows may have trouble assigning drive
letters to your ¢550 drives. Follow the steps on the next
page to assign (map) your drive letters.
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Problem/Question

Solution/Answer

| get a message
saying “Unsafe
Removal of Device”
when | unplug the
USB cable.

When you are ready to disconnect your c550 from your
computer, double-click the £= Unplug or Eject icon in
your system tray. Select USB Mass Storage Device,
and click Stop. Select the ¢550 drives, and click OK. You
can disconnect your ¢550 from your computer now.

How can | rename my
550 drives?

1. Open My Computer.

2. Select the drive you want to rename.

3.

4. Type the new name, and press the Enter key on your

Right-click your mouse, and select Rename.

computer’s keyboard.

How do | assign
(map) my c550 drives
in Windows?

—_

Turn off your ¢550.

Plug in the USB cable to the ¢550 and your computer.
Your ¢550 automatically turns on.

Click Start > Settings > Control Panel >
Administrative Tools > Computer Management >
Storage > Disk Management.

Click a 550 removable disk drive (either the internal
memory or your SD card drive). Right-click your
mouse, and select Change Drive Letter and Path....

Select Edit..., select a drive letter from the drop-down
list, and click OK.

¢550 Owner’s Manual
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APPENDIX

FCC Compliance

The unit complies with Part 15 of the FCC
interference limits for Class B digital devices
FOR HOME OR OFFICE USE. These limits are
designed to provide more reasonable protection
against harmful interference in a residential
installation, and are more stringent than “outdoor”
requirements.

Operation of this device is subject to the
following conditions: (1) This device may not
cause harmful interference, and (2) this device
must accept any interference received, including
interference that may cause undesired operation.

This equipment generates, uses, and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no guarantee
that interference will not occur in a particular
installation. If this equipment does cause harmful
interference to radio or television reception, which
can be determined by turning the equipment off
and on, you are encouraged to try to correct the
interference by one of the following measures:
+  Reorient or relocate the receiving antenna.
+ Increase the separation between the
equipment and the receiver.
+  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

40

+  Consult an experienced radio/TV technician
for help.

NOTE: The Garmin ¢550 has no user-
serviceable parts. Repairs should only be
made by an authorized Garmin service
center.

NOTE: Unauthorized repairs or
modifications could result in permanent
damage to the equipment, and void your
warranty and your authority to operated
this device under Part 15 regulations.

NOTE: The ¢550 is fastened shut with
screws. Any attempt to open the case to
change or modify the unit in any way
voids your warranty and may result in
permanent damage to the equipment.

Declaration of Conformity
Hereby, Garmin declares that this StreetPilot
c-series product is in compliance with the
essential requirements and other relevant
provisions of Directive 1999/5/EC.

To view the full Declaration of Conformity, see
the Garmin Web site for your Garmin product:
www.garmin.com/products/sp550/. Click
Manuals, and then select the Declaration of
Conformity.
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INDEX

Symbols
2-D, 3-D map view 25
A
About button 26
acquiring satellites 3
adding a Bluetooth
device 28
aligning the touch
screen 32
answering a call 15
antenna, external 32
anti-theft feature 6, 26
audio version 26
automated systems 16
avoiding road types 28
avoiding traffic 20, 28

B

battery 36

better route 6

Bluetooth
technology 14-19
settings 28-29

brightness 6

browsing the map 11,
34,35

C

calibrating the touch
screen 32

calling home 19

call history 18

call waiting 16
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caring for your ¢550 31
changing the paired

device 29
charging the ¢550 32
clearing user data 29
computer connection 22
configuring the ¢550 3
contact Garmin vi
current location,

saving 10
customizing your

¢550 25-29
Custom POIs 35

D
daylight saving 27
Declaration of
Conformity 40
deleting
all user data 29
character 9
custom POIs 35
Favorites 10
files 23
recent finds list 9
detail maps 25
diacritical characters 9
disconnecting USB
cable 39
driving directions 13
E
editing saved places 10
EGNOS 26
ejecting the USB 23

enabling detailed
maps 25
ending a call 16
expanding your
search 11
Extras 34, 35

F
Favorites 10
editing 10
finding 10
saving 10
FCC compliance 40
files
deleting 23
managing 22
supported types 23
transferring 22-23
finding places
by name 8
by postal code 7
intersection 7
item on the map 11
near another
location 11
recent selections 9
saved places
(Favorites) 10
FM traffic receiver 20—
21
fuse, changing 32
G
Garmin Lock™ 6,
26,32

INDEX

Garmin Travel
Guide™ 34

getting a phone call 15

Go! page options 7

going home 8-11

GPS 36

H

hands-free features 14—
19

hangup 16

home location 8

|

inacall 16

K
keyboard 9
kilometers 27

L

license agreement vi

loading additional
maps 33

locked up, ¢550 is 30

locking your ¢550 6

M
managing files 22-23
map
browse 11
customize 25
Map Info button 25
moving 11
update maps 33
version 25
view 25
zoom 11
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INDEX

MapSource 33
waypoints 34

menu page 3

miles 27

mounting the ¢550 2, 30

MP3 music files
loading 22
playing 24

mute a call 16

N

navigation settings 28

Next Turn page 13

(o)

on-screen keyboard 9

P
pairing a cellular
phone 15
phone book 17
PIN
Bluetooth 29
Garmin Lock 6
playing music 24
POIs, custom 35
position icon 12-13, 25
postal code 7
proximity alarms 26
R
recently found
locations 9
deleting 9
finding 9
registering your ¢550 32,
33

42

remote antenna 32
removable disk drive 23
removing/deleting a
phone 29
removing the mount 2
resetting
the max speed 13
the trip data 13
your ¢550 30
restoring settings 29
routing preferences 28

S
safety camera

database 35
Safe Mode 26
satellite signals 36
saving

places you find 7, 10

your current

location 10, 11

school zone database 35
SD card 22, 37
security location 6
serial number vi
settings, adjusting 25-29
setting your location 7,

show map 7
software license
agreement Vi
software version 26
special characters 9
specifications 37
spelling the name of a

place 8
stopping the USB 23
storing your ¢550 31
supported file types 22
switch to call waiting 16
system settings 26

T
technical
specifications 37
text language 27
time zone 27
tones 28
touch screen
aligning 32
calibrating 32
cleaning 31
Track Up 25
traffic 20
avoid 21,28
incidents 20
subscription 21
transferring files 22-23
Trip Information
page 13
troubleshooting 38
turn-by-turn
directions 13
U
unit [D 26
unit locked up 30
updating the ¢550
software 33
USB 1,23

mass storage
mode 22-23
troubleshooting 38
using automated
systems 16

v

vehicle icon 12-13, 25
vehicle type 28

voice dial 19

voice language 27
volume 6

w

WAAS 26

warranty 43
WebUpdater 33

z

zoom 11
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Limited Warranty

This Garmin product is warranted to be free from
defects in materials or workmanship for one year from
the date of purchase. Within this period, Garmin will

at its sole option repair or replace any components that
fail in normal use. Such repairs or replacement will be
made at no charge to the customer for parts or labor,
provided that the customer shall be responsible for

any transportation cost. This warranty does not cover
failures due to abuse, misuse, accident, or unauthorized
alteration or repairs.

THE WARRANTIES AND REMEDIES
CONTAINED HEREIN ARE EXCLUSIVE AND IN
LIEU OF ALL OTHER WARRANTIES EXPRESS
OR IMPLIED OR STATUTORY, INCLUDING ANY
LIABILITY ARISING UNDER ANY WARRANTY
OF MERCHANTABILITY OR FITNESS FOR
APARTICULAR PURPOSE, STATUTORY OR
OTHERWISE. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS, WHICH MAY VARY
FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE
FOR ANY INCIDENTAL, SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, WHETHER
RESULTING FROM THE USE, MISUSE, OR
INABILITY TO USE THIS PRODUCT OR FROM
DEFECTS IN THE PRODUCT. Some states do not
allow the exclusion of incidental or consequential
damages, so the above limitations may not apply to
you.

Garmin retains the exclusive right to repair or replace
the unit or software or offer a full refund of the
purchase price at its sole discretion. SUCH REMEDY

SHALL BE YOUR SOLE AND EXCLUSIVE
REMEDY FOR ANY BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin
authorized dealer or call Garmin Product Support for
shipping instructions and an RMA tracking number.
The unit should be securely packed with the tracking
number clearly written on the outside of the package.
The unit should then be sent, freight charges prepaid,
to any Garmin warranty service station. A copy of

the original sales receipt is required as the proof of
purchase for warranty repairs.

Garmin International, Inc.
Tel. 913/397.8200 Fax. 913/397.8282

Garmin (Europe) Ltd.
Tel. 44/0870.8501241 Fax 44/0870.8501251

Online Auction Purchases: Products sold through
online auctions are not eligible for rebates or

other special offers from Garmin. Online auction
confirmations are not accepted for warranty
verification. To obtain warranty service, an original or
copy of the sales receipt from the original retailer is
required. Garmin will not replace missing components
from any package purchased through an online auction.

International Purchases: A separate warranty

is provided by international distributors for units
purchased outside the United States. This warranty
is provided by the local in-country distributor and
this distributor provides local service for your unit.
Distributor warranties are only valid in the area of
intended distribution. Units purchased in the United
States or Canada must be returned to the Garmin
service center in the United Kingdom, the United
States, Canada, or Taiwan for service.



For the latest free software updates (excluding map data)
throughout the life of your Garmin products, visit the Garmin
Web site at www.garmin.com.
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